
Micro Focus Visual COBOL 2.0 for Eclipse

Release Notes



Micro Focus
The Lawn
22-30 Old Bath Road
Newbury, Berkshire RG14 1QN
UK
http://www.microfocus.com
  

Copyright © 2009-2012 Micro Focus. All rights reserved.

MICRO FOCUS, the Micro Focus logo and Visual COBOL are trademarks or registered
trademarks of Micro Focus IP Development Limited or its subsidiaries or affiliated
companies in the United States, United Kingdom and other countries.

All other marks are the property of their respective owners.

2012-04-18

ii



Contents

Micro Focus Visual COBOL 2.0 for Eclipse Release Notes ............................5
Installation .......................................................................................................... 6

System Requirements for Visual COBOL for Eclipse ......................................................... 6
Installing Visual COBOL for Eclipse ....................................................................................8
Installing Silently ............................................................................................................... 10
Installing X Windows on Windows .................................................................................... 12
Configuring the Environment for Developing RDBMS Applications on UNIX ................... 12
Repairing ...........................................................................................................................12
Uninstalling ........................................................................................................................13

Licensing Information ......................................................................................14
What's New ....................................................................................................... 16

New Features in Visual COBOL 2.0 ..................................................................................16
Automatic Directives Detection and Setting ........................................................... 16
COBOL Explorer View ............................................................................................16
COBOL File Search ................................................................................................18
Compiler Directives ................................................................................................ 18
Compiling Single Files ............................................................................................18
Enhancements to Developing Applications on a Remote Machine ........................19
Converting Net Express Projects ........................................................................... 19
Copybook Context ..................................................................................................19
Debugging Enhancements ..................................................................................... 20
Eclipse 3.7 ..............................................................................................................20
JVM COBOL File Handler ...................................................................................... 20
Library Routines ..................................................................................................... 20
Managed COBOL Language Features ...................................................................21
OpenESQL ............................................................................................................. 21
SQL Support ...........................................................................................................21
Remote COBOL JVM Projects - Early Release ..................................................... 21
Run-Time Tunables ................................................................................................21
Samples ................................................................................................................. 22
Vision Data File Searching ..................................................................................... 22

Features Added in Visual COBOL 2010 R4 Update 2 ...................................................... 22
New Platforms Support .......................................................................................... 22
OO COBOL Class Library Reference .....................................................................22
OpenESQL ............................................................................................................. 23

Features Added in Visual COBOL 2010 R4 ......................................................................23
ACUCOBOL-GT Compatibility ............................................................................... 23
COBOL for Java Virtual Machine (JVM) Support ................................................... 24
Embedded HTML ................................................................................................... 24
Improved Usability ..................................................................................................24
Language Improvements ........................................................................................24
Renamed Color Preferences ..................................................................................25
Reporting of Linker Errors ...................................................................................... 25
RM/COBOL Compatibility .......................................................................................25
XML Extensions ..................................................................................................... 25

Known Issues ................................................................................................... 27
Resolved Issues ............................................................................................... 28
Updates and SupportLine ................................................................................36

Further Information and Product Support ..........................................................................36
Information We Need ........................................................................................................ 36

Contents | 3



Creating Debug Files ........................................................................................................ 37
Disclaimer ......................................................................................................... 38

4 | Contents



Micro Focus Visual COBOL 2.0 for Eclipse
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Visual COBOL.
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Installation

System Requirements for Visual COBOL for Eclipse

Hardware Requirements

Windows Operating Systems:

Windows XP 64 bit SP2
Windows XP 32-bit SP3
Windows Vista SP1 32/64-bit
Windows 7 32/64-bit
Windows Server 2003 SP2 32/64-bit
Windows Server 2003 R2 32/64-bit
Windows Server 2008 SP2 32/64-bit
Windows Server 2008 R2 32/64-bit

Disk Space:

Approximately 42 Mb for the Sentinel RMS license server
Approximately 680 Mb for Visual COBOL. Note: This disk size includes the space needed
to cache information locally so that you can modify the installation without the original
source media.

UNIX Operating Systems:

x86-64 running Red Hat Linux 5.5/5.7/6.1 - 32/64-bit
x86-64 running SuSE SLES 11/11 SP1 - 32/64-bit

Disk Space:

33 Mb for the Sentinel RMS license server.
Approximately 399 Mb for Visual COBOL. Note: The installation requires extra disk space that
equals the size of the product you install.

Software Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file will install a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool.To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.
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• On Windows, if you use the Micro Focus Web Installer to install this product, it will check your system
and will install the missing prerequisite software.

• On UNIX, if you use the full image for the installation, you need to first install Java Platform Standard
Edition (Java SE) 6 Update 27. You can download Java SE from www.oracle.com and install it
anywhere on your machine.

• On UNIX, you must have xterm installed. Xterm, the terminal emulator for the X Window System, is part
of your Linux/UNIX distribution but is not installed by default. Use your Linux/UNIX installation media to
install it.

Before you start the installation, you need to set the environment as follows:

Windows • If you use XML Extensions, note that XML Extensions has the same requirements as RM/
COBOL version 12 for 32-bit Windows. (See the RM/COBOL User's Guide, Second Edition
or later.) Additionally, XML Extensions may be used in conjunction with Terminal Server.

UNIX • Before installing on Red Hat 6.1, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries – glibc-devel (i686 version)

Check the Red Hat Web site for more information.
• In order to use the Web installer on Red Hat Enterprise Linux 6.1, you must have the following

bug fix updates for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.el6.i686.rpm
nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.el6.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

You also need to:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a
32-bit Java installation or the installation will terminate. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/
javan.n

• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• Set the LANG environment variable in order to pick up localized messages. The LANG settings
are English and Japanese only.

Installation Restrictions

• Visual COBOL and COBOL Server cannot co-exist on the same machine. This applies to Windows
only.
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Installing Visual COBOL for Eclipse
Note:

• This version of the product is a full install.
• We recommend that you install this product using the Web Installer. On Windows, the Web

Installer helps you install any missing prerequisite software and the product on your machine.

Downloading the Product

1. Click on the product download link in your delivery notice.

This opens the Micro Focus Electronic Product Delivery page for your order.
2. Before downloading your product, check the Legal Information tab and read the End User License

Agreement.
3. Check the Documentation tab and read the documentation supplied for your product.
4. Check the respective links to download the setup file or the Web installer for your product for the

appropriate platform to your machine.

Installing

Windows To use the Web Installer:

1. Double-click the VisualCOBOLEclipse20_webinstaller.exe file.
2. Click Start in the Installer window and follow the instructions to install the pre-requisite

software and the product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Run the VisualCOBOLEclipse20.exe file and follow the wizard instructions to complete
the installation.

A full version of Eclipse, with the Micro Focus plugins already installed, will be present in the
C:\Users\Public\Micro Focus\Product Name\eclipse directory. On older versions
of Windows, Eclipse might be installed in a different folder, such as for Windows XP, in
install_dir\eclipse.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that
uses an older Sentinel RMS License Manager, you might be prompted to remove it
and install the Micro Focus License Manager. By doing this you will maintain the
existing Sentinel RMS license files while adding the Micro Focus License Manager.
If you are unsure about existing licenses on your computer or removing the Sentinel
RMS License Manager, consult your System Administrator. If you want to proceed,
remove Sentinel RMS License Manager by using Windows Add or Remove
Programs and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your
product in this way, please contact Micro Focus SupportLine to obtain a relevant
license.

• We recommend that you install any updates of the .NET Framework that are
available at the Microsoft Download site.

UNIX To use the Web Installer:
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1. You must give the Web installer file execute permissions:

chmod +x webinstaller_visualcobol_deveclipse_2.0_platform

2. Run the installer with superuser permissions:

./webinstaller_visualcobol_deveclipse_2.0_platform

If you don't run this as superuser, you will be prompted to enter the superuser password
during the install.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_2.0_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_deveclipse_2.0_platform

If you don't run this as superuser, you will be prompted to enter the superuser password
during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL.
A full version of Eclipse, with the Micro Focus plugins already installed, will be present in
the /opt/microfocus/VisualCOBOL/eclipse directory.

To install in a different location use the -installlocation="Location" parameter to
specify an alternative directory location. For example:

./webinstaller_visualcobol_deveclipse_2.0_platform -
installlocation="full path of new location"

or

./setup_visualcobol_deveclipse_2.0_platform -installlocation="full 
path of new location"

You can see details about which additional parameters can be passed to the install script if
you enter the -help option.

Note:

• The installation of this product may affect the SafeNet Sentinel licensed
components running on your machine. During installation licensing is shutdown
to allow files to be updated. To ensure the processes running on your machine
will not be affected, you need to use –skipsafenet option which skips the
installation of SafeNet:

./setup_visualcobol_deveclipse_2.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can
create an empty file named SKIP_SAFENET_INSTALL in /var/
microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer will not make changes to the
installation or shutdown the running license daemons. If later licensing needs to
be updated, remove the file and install Sentinel RMS server manually.

3. Set up the environment:

Important: These commands set the environment only for the current shell. You
need to execute them for each new shell that you start.

a. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv
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b. To verify that your product is installed and licensed, execute:

cob -Version

Tip: To avoid having to run cobsetenv for every shell, add these commands to
the shell initialization files (etc/profile, etc/bashrc, etc.)

c. To start Eclipse, double-click the icon for Micro Focus Visual COBOL for Eclipse
(automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the
desktop for the user for which you ran the install script. If you need to create
desktop icons for other users' desktops on the same machine, or if the icon was
not created on the desktop for the root user, run the following shell script as the
user you need to login as: $COBDIR/bin/createdesktopicon.sh

Installing as an Upgrade

UNIX This release works concurrently with version R4 of Visual COBOL, so you do not need to uninstall
it. There are two options for installing the latest version in this case:

• Move the R4 installation to a different location and install the latest version to the default install
location, /opt/microfocus/VisualCOBOL.

This ensures you do not need to change your environment. To move the existing older
installation to a different location:

1. Execute the following command:

[ as root ] mv /opt/microfocus/VisualCOBOL /opt/microfocus/
VisualCOBOLR4

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this,

run the Visual COBOL 2.0 installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/VisualCOBOL2.0"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL2.0/bin/cobsetenv

After You've Installed the Product

If you have used Eclipse from the same workspace before, note that the Eclipse perspective settings do
not get reset after installation. To pick up any new features, you must reset the COBOL perspective after
installation:

1. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
2. Click Window > Reset Perspective.
3. Click OK.
4. Reapply any customizations.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install.
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On Windows:

To install silently use the following command:

start /wait install-file.exe /q [parameters]

where install-file for the following products is as follows:

Visual COBOL VisualCOBOLEclipse20.exe

VisualCOBOLEclipse20.exe and COBOLServer20.exe include a number of individual .msi files,
where each .msi file installs one software component. For instance, VisualCOBOLEclipse20.exe
includes one .msi file to install Visual COBOL and another to install License Manager; running
VisualCOBOLEclipse20.exe installs both Visual COBOL and License Manager.

You can specify different parameters for the different .msi files within the same .exe file by using the /
componentargs parameter. Valid values for the /componentargs parameter are as follows:

• License Manager
• Visual COBOL

The examples show how to use the /componentargs parameter.

After the installation is complete you can install the license silently. You need to have your Authorization
Code. To install the license execute:

start /wait <install-dir>\bin\cesadmintool –term activate AuthorizationCode

Directory Considerations (Windows)

• You must have read and write access for every directory accessed during the install.
• You can override the default installation folder using the INSTALLDIR parameter:
• If a path in a definition contains spaces, then the path must be preceded by a backslash and double

quotation mark (\"). For example:

INSTALLDIR=path
INSTALLDIR=\"c:\MyProduct\" 
INSTALLDIR=\"c:\Program Files\Micro Focus\My Product\"

• Installing creates a log file in %temp%\LogFilename by default. To change the location or name, use
the /l parameter on your Setup command line and specify the path and file name, for example:

/l*v drive:\path\LogFilename

The default names for the log files are as follows:

VisualCOBOL_install_log.txt for the Visual COBOL wrapper

VisualCOBOLx??_install_log.txt for Visual COBOL, where ?? is "86" for 32-bit systems
and "64" for 64-bit systems.

lmsetup_install_log.txt for License Manager

EnterpriseServerDotNet_install_log.tx
t 

for COBOL Server for .NET

• The log filename and folder name cannot contain spaces
• The log file folder must exist before beginning the silent install

Examples

• To silently install Visual COBOL into a directory other than the default:

start /wait VisualCOBOLEclipse20.exe /q /componentargs "Visual
COBOL:INSTALLDIR=c:\DirectoryName"
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On UNIX:

You can use the following command line arguments to install silently on UNIX:

–silent -IacceptEULA

For example, execute:

webinstaller_filename –silent -IacceptEULA

or

setup_filename –silent -IacceptEULA

Installing X Windows on Windows
Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in your
Visual COBOL installation. By default this will be in the %ProgramFiles%\Micro Focus\Visual
COBOL\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Configuring the Environment for Developing RDBMS
Applications on UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

In order to do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Repairing
On Windows, if any product files, registry settings or shortcuts are accidentally removed at any point, you
can perform a Repair on the installation to replace them.

To repair your installation on Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
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4. Click Repair.

To repair your installation on Windows Vista or Windows 7:

1. Click Start Menu > Control Panel.
2. Click Uninstall a program under Programs.
3. Right-click your Micro Focus product and select Repair.

Uninstalling
Note: The installer creates separate installations for Micro Focus Visual COBOL (or COBOL Server)
and Micro Focus License Manager. Uninstalling only Visual COBOL (or COBOL Server) does not
automatically uninstall the Micro Focus Licensing Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus Licensing Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Windows To uninstall Visual COBOL and the other Micro Focus components, use the Windows Add or
Remove Programs tool.

UNIX To remove Visual COBOL (or COBOL Server), execute as the root user the
Uninstall_VisualCOBOL20.sh script in the /opt/microfocus/VisualCOBOL/bin
directory.

To uninstall Micro Focus License Manager, run the UnInstallMFLicenseServer.sh script
in the /microfocuslicensing/bin directory. The script will not remove some of the
files as they contain certain system settings or licenses.
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Licensing Information
Note:

• This release uses the license keys for the Visual COBOL R4 release.
• This release requires the latest version of SafeNet licensing software. See Software Requirements

in this document for more details.
• If you are unsure about what your licensing policy is or what sort of license you require, consult

your System Administrator or Micro Focus SupportLine to obtain a valid license.

Windows Use the Authorization Code, supplied with your delivery notice, to license your product. To do
this:

1. Click Start > All Programs > Micro Focus License Manager > License Management
System.

The dialog box for the Micro Focus License System Administration Tool will be displayed.
2. Click the Authorize tab.
3. Enter your Authorization Code and click Authorize.
4. Close the Micro Focus License System Administration Tool.

If you wish to install the license silently, execute the following after the product has been
installed:

start /wait <install-dir>\bin\cesadmintool –term activate 
AuthorizationCode

UNIX The Micro Focus Licensing System is installed into the /var/microfocuslicensing
directory.

To license your software:

1. Run the Micro Focus Licensing Administration utility:

sh /var/microfocuslicensing/bin/cesadmintool.sh

Note:

• You need permissions to write to the license file which normally means you need
to log in as root.

• Make sure Java is on the PATH before you run the utility. See System
Requirements for more information.

2. Select an option as appropriate and press Enter:

If you have access to the Internet:

Select Online Authorization. You will be prompted to enter the Authorization Code
supplied with your delivery notice.

If you do not have access to the Internet:

You need the license strings. In order to obtain them, you need your Authorization Code,
your Machine Id and a machine with access to the Internet.

a. Choose Get Machine Id and press Enter.
b. Make a note of the information which is displayed.
c. On the machine which is connected to the Internet, open http://

supportline.microfocus.com/activation/ in a browser.
d. Follow the instructions to obtain the license strings and save them to a text file.
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e. Copy the text file to the first machine on which you are installing the product.
f. At the command line, select Manual License Installation from the licensing options

and enter the full name of the file containing the license strings.

License for the Integrated Development Environment for Eclipse

Your product is supplied with an evaluation license that typically enables you to use your product for 30
days. While you are using the evaluation license, a dialog will display when you start your product
prompting you to enter the Authorization Code. This code can be found in the Requested License Key
email that is supplied when you order your product. Depending on your product order, you might have
multiple license Authorization Codes. To obtain a full license for Visual COBOL, enter the code that is
printed under Visual COBOL - Visual COBOL for Eclipse.

Note: If you have purchased a Visual COBOL timed license, the license management system may
show these as Trial licenses. This does not affect the license you have purchased.

Note: An XSERV964 license key is supplied for ViewNow X Server.

License for COBOL Server for Unit Testing

You need to install this license to run and test your applications in the runtime environment. It is a timed
license and expires after one year after the date of purchase. After this time you need to contact Micro
Focus to request a renewal.

There is no evaluation period for this license and you need to use your Authorization Code to obtain a full
license before you can test your applications. The Authorization Code can be found in the Requested
License Key email that is supplied when you order your product. To obtain a full license use the code that
is listed under Visual COBOL - COBOL Server for Unit Testing.
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What's New
The following sections outline the new features that have been added in this release of Visual COBOL for
Eclipse.

New Features in Visual COBOL 2.0

Automatic Directives Detection and Setting
It is now possible to automatically determine and set the COBOL dialect and SQL directives on native
COBOL source code. In the COBOL Explorer, select Determine Directives from the context menu for the
projects or the COBOL source files. This triggers a scan to determine the COBOL dialect and SQL settings
and sets them as Compiler directives on a file or project level respectively. At the end of the scan, you view
the results and choose to apply the changes.

This feature works with local or remote native COBOL projects only.

COBOL Explorer View
Visual COBOL now includes the COBOL Explorer view in the Eclipse IDE. This allows you to navigate
around COBOL projects in a more useful and convenient way than Eclipse's own Navigator view.

The COBOL Explorer view includes the following features to help you manage your projects:

• For COBOL Project and COBOL Remote Project types, COBOL Explorer adds category folders that
automatically group together your project's COBOL programs, copybooks, and output files. These
folders are not physical folders on the disk, but map project folders that are, if they contain programs or
copybooks.

• To simplify navigation around your project, you can hide some files that are part of the project, such as
the .cobolBuild, .cobolProj, and .project files, and the .settings folder and its content in
JVM projects. You do this by opening the view menu, selecting Customize View and choosing from the
options.

Filters Choose types of content to hide in COBOL Explorer.

Option Description

.*resources Any files of type .* such
as .cobolBuild, .cobolProj

Closed projects Resources in closed projects never display, but
you can choose to hide all closed project icons

 too

Empty folders inside COBOL categories Folders mapped to the COBOL Programs and
Copybooks that contain no COBOL program or
copybook files

Non-COBOL projects Projects of types other than those under Micro
Focus COBOL - for example AspectJ, Plug-in, or
Update-site projects

RSE Internal projects Projects generated by the RSE plug-in
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Content Choose types of content to show in COBOL Explorer.

Option Description

Working Sets Working sets are subsets of workspace
resources you can choose to show or perform
options on. To define a working set, click Project
> Build Working Set > Select Working Set >
New.

COBOL Elements Non-resource types that are COBOL-specific:

1. x
2. category folders, including those for COBOL

programs and copybooks
3. icons for the different types of COBOL files.
4. overlays for build errors and warnings
5. some context menu items

Resources COBOL projects, COBOL programs and
copybooks. Has effect only if the COBOL
Elements option is unchecked.

• COBOL Explorer helps you fix problems by using icons to identify files and containers that cause build
errors and warnings.

• A file that generates a warning, and any containing folders and categories, is marked with a yellow
warning sign. For example:
 

 
• A file that causes an error, and any containing folders and categories, is marked with a cross. In this

example the icons indicate the most severe problem is the error caused by Program4.cbl, and
the folders are marked with error icons despite Program5.cbl generating a warning:
 

 
• A project that suffers from a dependency error is marked with a red exclamation mark; its contents

remain unmarked. In this example the project depends on another project that is closed, causing a
build path problem:
 

 

Also, the context menus are reorganized and include some additional tasks such as the Determine
Directives command.

You access COBOL Explorer in the same way as other Eclipse views, by selecting Window > Show View.
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COBOL File Search
Visual COBOL now includes the COBOL File Search feature in the Eclipse IDE.

There are two ways to use the COBOL File Search feature to make it easier to find certain files within your
projects.

• Select Search > COBOL File, and type the filename search string.

You can filter results based on

• file type: choose from COBOL programs, copybooks.
• only those files that cause build errors
• only those files that cause build warnings

• Select Search > Run Stored COBOL Search Query and choose to find either:

• only those files that cause build errors
• only those files whose properties override the project's properties (for example Language dialect or

Compile for debugging settings).

The results are shown in the Search view.

You can edit the properties of multiple files in the search results simultaneously if they come from the same
project. Highlight the files you want to change, right-click and select Properties, and make sure Enable
file specific settings is selected.

Tip: You can save your search criteria and give it a label, which adds it to the list of stored queries
available when you select Search > Run Stored COBOL Search Query. When saving a search you
can also assign it a keyboard shortcut by entering the required keystrokes in the Binding text box.

Save and edit your search either in the Search view, or the Windows > Preferences > Micro Focus
COBOL > Search dialog box.

Make sure you don't open the Keys preferences page (Windows > Preferences > General > Keys)
before or after you edit the binding in the Search preferences page, and before clicking OK to save
any changes. Opening the Keys preferences page will prevent any changes you make to the search
bindings being saved.

Compiler Directives
The following new directives are now available:

• COPYSEARCH - enables you to specify how copybooks are located. You can choose between usual
Micro Focus COBOL behavior or usual RM/COBOL behavior.

• ILSMARTNEST - enables you to nest ILSMARTLINKAGE classes inside the program class in which
they are defined. This makes it possible to have multiple programs in a single compilation unit that
include linkage records with the same name.

The following directives have been changed:

• DIALECT(RM) - now accepts a new parameter, RM, which enables the RM-compatible functionality that
the RM directive used to enable.

• ILREF - can only specify a .class as a parameter, and not a .jar file or other file types.
• ILUSING - when set on a single file using the SET statement, $set ilusing, the directive only affects

that file.

Compiling Single Files
It is now possible to compile individual COBOL source files without rebuilding your entire project. Build
Automatically on the Project menu must be turned off.
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Enhancements to Developing Applications on a
Remote Machine
Previously, this product depended on Samba or NFS to transfer and manage the project files on a remote
UNIX machine. Remote Server Explorer (RSE) was only used to build the applications on remote
machines.

"Remote file system (RSE)" is now the default option in the Create Remote COBOL project wizard for
managing the files of remote COBOL projects. RSE establishes a connection with the remote machine and
is used to transfer and manage the project files on it.

Important:

• You must use SSH connection and not DStore for remote COBOL projects created with Remote
file system (RSE).

• You can still use Samba and NFS as file system providers. On system where SSH is not allowed,
you can use SAMBA and DStore connection to transfer and manage the files on the remote
system.

Converting Net Express Projects
Note: This topic applies to Windows environments only.

It is now possible to convert Net Express projects into Eclipse projects and use them with Visual COBOL.
To do this, use the Net Express Project Import and Convert Wizard available from File > Import > Convert
NetExpress Projects to COBOL Projects. The wizard analyzes the Net Express project file and its
configuration settings, creates Eclipse projects based on this information, imports the existing source code
into them, and sets the requisite project and file properties from the original Net Express project.

Note: If you import a Net Express project that uses functionality that is not supported in Visual
COBOL, the wizard will still produce an Eclipse project. In some cases you might be able to perform
additional steps (such as editing source files, installing AddPacks, or reworking parts of the
application) in order to successfully compile and run it. See Converting Net Express Projects to
Eclipse Projects for more information about the limitations of the wizard.

Copybook Context
When you view or edit a copybook, you need to see it in the context of the program that references it, as its
appearance and usage can change depending on the program. For example, data items that are not used
in the program are struck through, and horizontal lines indicating the start and end of code lines can show
depending on the source format of the program. The Program Outline view can differ between contexts
too.

You can choose which context to open a copybook by right-clicking on the file in COBOL Explorer and
selecting Open In Context. A list is displayed of all the programs that include a COPY statement
referencing the copybook. You can also choose to open the copybook in no particular context.

Whichever you choose becomes the copybook's context whenever you right-click the copybook in COBOL
Explorer and select Open. It also determines which program it is displayed within when you right-click in
the copybook source and select Open in Copy View.

A breadcrumb trail at the top of the Editor indicates which program and copybooks are the current context -

click Toggle Context Breadcrumbs  in the Eclipse toolbar and use the drop-down list to view and open
the dependent copybooks.
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Debugging Enhancements
This release provides the following enhancements to debugging:

Program
Breakpoints

Note: Program breakpoints are supported in native COBOL only, and are not
supported with nested programs.

You can now set program breakpoints, which break into a program whenever it or
one of its entry points is called.

To set or toggle a program breakpoint, double-click in the left margin, next to the
Procedure Division heading. The  icon appears when the program breakpoint is
set.

Step out of OSVS
perform
statements

You can now step out of a perform statement when PERFORM-TYPE(OSVS) or
DIALECT(OSVS) is set.

Eclipse 3.7
This release of Visual COBOL uses Eclipse 3.7.1 Indigo.

JVM COBOL File Handler
Use the JVM COBOL File Handler, a File Handler written in purely JVM COBOL managed code, when you
are deploying to environments that do not allow the use of native code such as the default Micro Focus File
Handler.

Library Routines
The following CTF library routines are now available in COBOL for JVM:

CBL_CTF_COMP_PROPERTY_GET
CBL_CTF_TRACE
CBL_CTF_TRACER_LEVEL_GET
CBL_CTF_TRACER_GET
CBL_CTF_LEVEL

The following routine has been enhanced:

• The CBL_SEMAPHORE_ACQUIRE routine now accepts a timeout parameter.
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Managed COBOL Language Features
The following new syntax elements are now available in managed COBOL:

Local
Variables

In managed COBOL, Data items can now be declared in the procedure division, using
the DECLARE statement. In addition, they can be declared inline as the iterator in a
PERFORM statement, or as an exception message in a TRY … CATCH … FINALLY
statement block.

Collections There are two new collection types in managed COBOL: LIST and DICTIONARY. For a
LIST, you can add elements to a list, retrieve the nth element of the list, replace the nth
element, iterate through the list and clear the list. For a DICTIONARY, you can add key
value pairs, retrieve a value corresponding to a key, to replace the value corresponding
to a key, iterate through the dictionary and clear the dictionary.

Properties In managed COBOL, a property can now be defined using PROPERTY-ID and GETTER
and SETTER phrases to access to the property. The previous technique of specifying
the keyword PROPERTY on a data declaration is still available.

Indexers In managed COBOL, an indexer can now be defined using INDEXER-ID and GETTER
and SETTER phrases to access the indexer value. Indexers are similar to properties,
except that their accessors take parameters. Indexers allow instances of a class or
valuetype to be indexed just like arrays.

Zero-based
Indexing

The managed COBOL syntax for arrays now uses zero-base indexing to access arrays
when square brackets are specified. For backward compatibility, one-base indexing is
used when round parentheses are specified.

The Help now contains code examples comparing managed COBOL and Java.

OpenESQL
The JDBC preprocessor option enables you to access databases for applications running under the Java
Virtual Machine (JVM). It is now available on Unix and Linux.

SQL Support
This release provides the following enhancements:

• Improved IDE integration with SQL directives - now supports handling of deprecated and removed
directives. Also supports filtering of the choices offered to the user by product type, project type, and
platform.

• OpenESQL has been enhanced and it now:

• defaults to optimal performance
• supports 64bit ODBC across all platforms
• OpenESQL now supports JDBC across all platforms

Remote COBOL JVM Projects - Early Release
You can use Eclipse to develop COBOL JVM projects on a remote UNIX/Linux machine. The source code
resides and is being compiled and debugged on the remote machine.

Run-Time Tunables
This release provides the following new tunable:
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• subsystem_cancel_mode - use this to override the default cancel mode when you use the
CBL_SUBSYSTEM library routine to cancel a subsystem.

Samples
The following new samples are now available:

• Collections - demonstrates the managed COBOL collections syntax
• Local Variables - shows how to declare data items in the procedure division in the DECLARE,

PERFORM and TRY statements
• The code in the Properties sample has been enhanced to use the new PROPERTY-ID syntax. The

sample also includes a sample program for Indexers which illustrates the new INDEXER-ID syntax.

Vision Data File Searching
This release provides the following new ACUCOBOL-GT compatible environment variables to help search
for Vision data files at run time:

APPLY_FILE_PATH
FILE_CASE
FILE_PREFIX
FILE_SUFFIX

Features Added in Visual COBOL 2010 R4 Update 2

New Platforms Support
Support for Visual COBOL for Eclipse has been added for the following platforms:

• x86-64 running Red Hat Enterprise Linux 5.7/6.1
• x86-64 running SuSE SLES 11 SP1

Support for Visual COBOL Development Hub has been added for the following platforms:

• x86-64 running Red Hat Enterprise Linux 5.7/6.1
• x86-64 running SuSE SLES 11 SP1

Support for COBOL for JVM has been added for the following platforms:

HP IA 11.31 - 32/64-bit
x86-64 running Red Hat Linux 5.6/6.1 - 32/64-bit
SPARC running Solaris 10 - 32/64-bit

OO COBOL Class Library Reference
On Windows, Help for the following OO COBOL class libraries is available:

Base class library
GUI class library
OLE class library
OLE Automation class library

The Help is available in the file nxrclr.chm, which is installed in the Help folder of your installation. The
default location is%ProgramFiles%\Micro Focus\Visual COBOL\Help.

To open the help, double-click nxrclr.chm in Windows Explorer.
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Help for the OO COBOL class libraries are available from the Micro Focus SupportLine Web site, as
follows:

1. Go to the Server Express documentation, at http://supportline.microfocus.com/documentation/books/
sx51ws02/sx51indx.htm.

2. Click Reference > OO COBOL.
3. Expand OO COBOL Class Library Reference.

OpenESQL
OpenESQL now includes the JDBC preprocessor option that you can use to access databases for
applications running under the Java Virtual Machine (JVM).

Features Added in Visual COBOL 2010 R4

ACUCOBOL-GT Compatibility
The Compiler and run-time continue to provide support for ACUCOBOL-GT. The directive ACU is the main
switch for turning on ACUCOBOL-GT compatibility. The ACU directive enables various ACUCOBOL-GT
syntax extensions and other language elements. Additional ACUCOBOL-GT compatibility features include
the following:

• When using a CALL statement, the USING and GIVING/RETURNING phrases can now appear in
either order.

• The following ACUCOBOL-GT standard library routines can now be used with Visual COBOL in native
code:

• C$CALLEDBY
• C$CALLERR
• C$CHDIR
• C$MAKEDIR
• C$MEMCPY
• C$MYFILE
• C$PARAMSIZE
• C$RERR
• M$ALLOC
• M$FREE
• M$COPY
• M$FILL
• M$GET
• M$PUT
• WIN$VERSION

• The following ACUCOBOL-GT 'ccbl' compiler options can now be used with Visual COBOL:

• -E, -V
• -Cv
• -Da, -Db, -Dd31, -DL1/2/4/8, -Dq, -FpRounding
• -La, -Li, -Lc, -Lf, -Ll, -Lo, -Ls, -Lw

Note: The output that these list options provide differs in Visual COBOL.
• -Qm
• -Rc, -Rn, -Rw
• -Sa, -St, -Sd, -Sp, -S1...-S9
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• -noTRUNC, -truncANSI, -Dz
• -Td, -Te
• -Vc
• -Za, -Zc, -Zl, -Zn, -Zs, -Zi, -Zr1, -Zy, -arithmeticVSC2

Full ACUCOBOL-GT compatibility is documented under the Programming section in the product help.

COBOL for Java Virtual Machine (JVM) Support
In this release you can compile COBOL applications to JVM byte code (.class files) so that they can be
run on a JVM. There is support in the IDE to edit, compile and debug JVM COBOL applications. This
release includes Managed COBOL - COBOL with extensions to support the JVM framework plus OO
syntax support.

Features include support for

• New managed COBOL syntax:

• The SYNC statement, which marks a statement block as a critical section by obtaining the mutual-
exclusion lock for a given object, executing a block of statements, and then releasing the lock.

• Extension methods, enabling you to extend an existing class with new methods without the need to
recompile the existing class

• Java style inner classes, which define a nested class within another class. These follow all the
methods belonging to the containing class.

• The STATIC keyword, enabling you to mark methods and data as static.
• Enumerators, which represent a list of constant values. You can declare an enum type that defines

the values and symbolic names for them, and refer to the values by name in your code.
• Seamless interoperation between JVM COBOL and native COBOL
• The ability to add Java projects to the classpath for COBOL JVM projects, and COBOL JVM projects to

the classpath for Java projects
• Red Hat, AIX and SUSE platforms

Embedded HTML
We now support the use of Embedded HTML (EHTML) in COBOL CGI programs, which enables you to
output HTML directly from your applications.

Improved Usability
The following improvements to COBOL development in Eclipse have been made:

Dialog box improvements The dialog boxes governing build configuration, debug configuration,
and launch configuration are redesigned to make them easier to use.

Autocompletion and Content
Assist

The IDE now includes autocompletion and content assist editing
features.

Language Improvements
The following improvements have been made to managed COBOL:

Extension methods
and extending
operators

Managed COBOL now supports extension methods. This feature enables you to
add methods to existing types without the need to edit or recompile the code. You
can also extend operators.
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The SYNC modifier
for methods

The SYNC modifier locks the values of the arguments sent to the method, so that
they do not change while the method is processing.

Nested classes In managed COBOL, a nested class can now be defined so that it can access the
instance fields, properties and methods in its containing class. To allow this, you
add the optional SHARING PARENT phrase to the nested class definition.

Renamed Color Preferences
The COBOL Editor syntax-coloring scheme called "Micro Focus Net Express" is now called "Micro Focus
Traditional".

The syntax-coloring element called "Identifiers" is now called "Identification Division Names".

Any existing settings for these options will not change.

Reporting of Linker Errors
Errors relating to linking, such as undefined entry points and libraries not being found, are now logged in
Eclipse's Problems view.

RM/COBOL Compatibility
The Compiler and run-time continue to provide support for RM/COBOL. Additional RM/COBOL
compatibility features include the following:

• The following RM/COBOL standard library routines can now be used with Visual COBOL in native code:

• C$Century
• C$ConvertAnsiToOem
• C$ConvertOemToAnsi
• C$DARG
• C$Delay
• C$GetEnv
• C$GetNativeCharset
• C$LogicalAnd
• C$LogicalComplement
• C$LogicalOr
• C$LogicalShiftLeft
• C$LogicalShiftRight
• C$LogicalXor
• C$NARG
• C$SetEnv
• C$RERR
• DELETE
• RENAME

• The RM/COBOL file handler can now be used with Visual COBOL, enabled by using the
CALLFH(ACUFH) Compiler directive, and then configuring an add-on to the Vision file handler.

Full RM/COBOL compatibility is documented under the Programming section in the product help.

XML Extensions
Note: This functionality is supported in native COBOL only.
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You can now use XML Extensions, the system that enables your COBOL applications to interact with XML
documents, with Visual COBOL.

XML Extensions has many capabilities. The major features support the ability to import and export XML
documents to and from COBOL working storage. Specifically, XML Extensions allows data to be imported
from an XML document by converting data elements (as necessary) and storing the results into a matching
COBOL data structure. Similarly, data is exported from a COBOL data structure by converting the COBOL
data elements (as necessary) and storing the results in an XML document.

For more information about XML Extensions, refer to the XML Extensions User's Guide, available from the
RM/COBOL product documentation set, in the SupportLine section of the Micro Focus Web site.
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Known Issues
Please refer to the Known Errors and Restrictions topic in the Product Information section of your product
Help.

In addition, please note the following:

Co-existing with Earlier Micro Focus Products

Run-time system
error due to
COBCONFIG

A run-time system error occurs if either the COBCONFIG or COBCONFIG_
environment variable is set when you run aVisual COBOL application or when you
use Visual COBOL to edit or create projects and the configuration file it refers to
contains entries that are not valid for Visual COBOL.

For example, this might happen if you have Net Express or Studio Enterprise Edition
installed and either COBCONFIG or COBCONFIG_ is set for it.

To work around this issue, ensure that Visual COBOL is not running and then modify
the configuration file by doing one of the following:

• If the invalid tunable is not needed by another application, remove it from the run-
time configuration file.

• Add the following as the first line in the configuration file:

set cobconfig_error_report=false

• Unset COBCONFIG (or COBCONFIG_) or set it to another configuration file that
does not contain the invalid tunable for the particular session you are running in.

File Handling

When using a CGI/ISAPI application developed with the Net Express HTML Forms Designer in Visual
COBOL, you may receive an error “unresolved external symbol _NMCNVRTI” or “unresolved external
symbol _NMCNVRTO”.

To work around this issue, add the corresponding .obj file to the Additional Directives in the project
properties, or use them from the command line to link the application: cbllink filename.cbl
NMCNVRTI.OBJ (or cbllink filename.cbl NMCNVRTO.OBJ, respectively).

Fileshare

A write of a record with an alternate key where the alternate key is the first value for that key may could
now return a 0/2 file status rather than a 0/0 status if a record with that alternate key value has been
deleted by uncommitted transaction (possibly the same transaction as that performing the write).

Java Support

Running a 64-bit Java application using cobjrun may cause the application to crash with a memory fault.
This is part of a problem between Redhat Linux v6.1 and Oracle Java that affects 32-bit processes
(cobjrun) executing 64-bit processes. To work around this issue, run 64-bit Java applications with
cobjrun64.
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Resolved Issues
The resolved issues that customers have reported are listed in this section. The numbers that follow each
issue are the Reported Problem Incident number followed by the Customer Incident Numbers (in
parentheses). RPIs that have numbers only (and no text) are included to confirm that the RPIs have been
fixed, since no further information is required.

• Animator (Character version)
• Compiler
• Compiler ECM Support
• Documentation
• Eclipse - Debug
• Eclipse IDE
• File Handling - External File Handler
• File Handling - Fileshare
• File Handling - Rebuild
• File Handling - Sort
• Interface Mapping General
• MFSupportInfo
• OLE Domain Support
• RTS
• Setup Issues
• Setup Issues (UNIX)
• SQL Support (non-Compiler)
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: OpenESQL
• Vision File System
• XML Extensions

Animator (Character version)

• When using the Step function to debug a program running on Solaris that contains a DECLARATIVES
section, the execution points are now correctly highlighted.

1081749 (2544940)

Compiler

• In constructs of type "STRING item1 item2 INTO identifer1", if the identifer uses a reference
modification, the length from the picture clause definition was incorrectly used when determining if
item1 and item2 fit into identifer1.

586313 ( )
• Invalid syntax errors are no longer produced when compiling screen section items.

1082549 (2549214)
• ACUCOBOL-GT reporting has been enhanced and now produces a Compiler error for the following

syntax which is not yet supported: ACCEPT... CURSOR <data-item>.

1081729 (2544855)
• An XML GENERATE statement on a record containing an ambiguous name whose case is distinct from

the other declarations of that name now executes as expected.
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1081691 (2543133)
• The ACUCOBOL-GT syntax ACCEPT ... DISPLAY OMITTED previously caused an internal Compiler

error.

1081423 (2538935)
• Compiling a program which contains an XML GENERATE statement to exe no longer produces

unresolved external symbol errors.

1078019 (2498657)
• Illegal ODO items which reference many levels of qualification now display a syntax error.

1080616 (2530541)
• Executing a statement using an intrinsic function with a reference modified argument when compiled

with SSRANGE(2) no longer produces spurious run-time errors.

1080275 (2526877)
• The RECORD-POSITION operator returned a value that was one less than the correct value.

586672 ( )

Compiler ECM Support

• A declaration of SQL TYPE ROWID was sometimes not processed correctly.

1080477 (2529596)

Documentation

• The following run-time system tunable is available: subsystem_cancel_mode. Specifies whether logical
or physical cancels are used for CBL_SUBSYSTEM cancels. Syntax:

>>-----set subsystem_cancel_mode---.-0-.----------->< +-1-+

Parameters: 0 Physical cancels: any programs canceled with a CBL_SUBSYSTEM cancel will be freed
from memory, making more memory available. 1 Logical cancels: any programs canceled with a
CBL_SUBSYSTEM cancel will not be freed from memory. The programs are available to be reused and
hence the performance of CALL/CANCEL statements is greatly increased. As far as your program is
concerned, the behavior of logical and physical cancels is identical. Properties: Default: 0 on Net
Express; 1 on Server Express

1080440 (2529528)
• If a compilation unit includes a class, and a version of the class already exists on the classpath, the

results are undefined. To avoid this problem, either keep a separate runtime and compilation classpath,
or delete built artifacts before compilation.

584421 ( )
• If you use the full image when installing Visual COBOL or the Development Hub, you must first install

Java Platform Standard Edition (Java SE) 6 Update 27.

1082268 (2550806)
• This release requires version 10000.2.660 or later of the Micro Focus licensing software. For local

servers, you do not need to install it separately, as the setup file will install a new client (Visual COBOL)
and a new licensing server on the same machine. If you have a network server, you must update the
license server before installing the product as the client is not able to communicate with license servers
of versions older than 10000.2.660. You can check the version of your license server by clicking Help >
About in the Micro Focus Licensing System Administration tool.

1082175 (2549745)
• In order to successfully complete the example of Java Calling JVM COBOL in the Interoperability

section of the documentation, you must add mfcobol.jar to the project's classpath.

585406 ( )
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• The CBL_DIR_SCAN_READ routine returns the filename only for native Windows projects, and the
filename with relative path for JVM and UNIX projects.

1082531 (2553002)

Eclipse - Debug

• Trying to launch a debug session specifying a UNIX shared object resulted in a RTS 173 error "Called
program file not found in drive/directory."

1080976 (2529615)

Eclipse IDE

• Typing in the sequence area now works like typing in a regular text editor - it moves to the right all the
text after the cursor and doesn't delete the charaters at area end. If you want to overwrite characters in
the area, you can switch insert mode to overwrite by using "Insert" key.

574736 ( )
• Compiler directives are colorized in the COBOL Editor.

583488 ( )
• Typing in the sequence area moves text after the cursor to the right and doesn't delete the characters at

area end. To overwrite characters in the area, switch to insert mode by pressing the Insert key.
Pressing the Tab key in the sequence area indents the text if the option "Pressing Tab in the sequence
number area moves caret to area A" is not selected. Pressing the Tab key when there is a multiline
selection aligns the text to the area margins.

581796 ( )
• If you ran a program using the “Run As > COBOL program” command, any ACCEPT statements in your

code would cause the execution to block. This is because the output would appear in the Eclipse
console instead of a new window.

1082925 (2557866)
• COBOL File Search uses the case sensitivity of the client file system.

586971 ( )

File Handling - External File Handler

• When reading a file cataloged as DISP=SHR the file handler now buffers the read for better
performance.

1079491 (2518330)
• DUMMY files defined as indexed now open correctly on UNIX platforms.

1079483 (2516513)
• Dataset concatenations ending with DD DUMMY (or DSN=NULLFILE) no longer cause an abend when

the file is closed.

1078960 (2511384)
• When opening a file for I-O under mainframe emulation, the file does not have to exist.

1078362 (2501743)
• A series of concatenated files will now all be opened with the same opcode so it is treated as a single

file.

1078617 (2503276)
• Missing indexed files in the USE statement incorrectly resulted in a 114 error. A 9/013 I/O error is now

correctly displayed.

583179 ( )
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• SORT did not display correctly the report fields (such as sections, headers, trailers) when no OUTREC
was specified.

583227 ( )
• An invalid input detected in the SORT FIELDS statement caused the application to crash. A 114 error

message was incorrectly displayed. This has been changed and an error “Command statement error(s)
detected” is now displayed.

583425 ( )
• Setting STRIPSPACE to OFF now correctly honors the record length and allows trailing spaces for

LSEQ files.

573921 ( )
• Support has been added to allow trailing spaces in LSEQ files when used with the variable

STRIPSPACE=OFF, when printing records via stdout or piping to a file.

585740 ( )
• Sequential files on a 64-bit machine are now correctly padded to fill the LRECL.

586461 ( )
• A memory leak could occur when performing file I-O operations inside a Web service.

1081398 (2540611)

File Handling - Fileshare

• An fsview close file now correctly closes the file.

1079724 (2508855)
• A CICS close on a file no longer fails if a transaction has started and updates are made to any file.

1079738 (2473753)
• Using a READ statement after a CLOSE REEL through Fileshare could result in a 9/077 error.

587474 ( )

File Handling - Rebuild

• If the checkpoint LAST is set and no checkpoint exists, BATCH BACKOUT now backs out of the entire
log.

1081493 (2541220)
• Rebuild will no longer try to rebuild an indexed file without any keys, and will report the failure. Rebuild

now also reports that there are no keys when performing file validation or file information on the file.

1078000 (2499296)

File Handling - Sort

• The NUM function has been added to SORT.

1079136 (2512764)
• The TOOLMSG output "Number of records resulting from criteria:" now displays the number of records

correctly.

1079280 (2513886)
• Users can now use the DATEn+r field constants as well as comparing DATE constants within the

INCLUDE/OMIT statements.

1078273 (2501816)
• NODETAIL now correctly prevents data records from being displayed in the OUTFIL. SORT will also

correctly default to displaying the entire input record if neither NODETAIL or an OUTREC is specified.

1074166 (2443710)
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• COUNT will now work correctly, representing a count of the number of data records in that section. The
value of SUBMAX will now be output when defined in the OUTFIL.

1080528 (2443710)
• SORT will now regard the next line as a continued comment (and will therefore ignore everything on

that line) if the previous line is a completed statement and has a comment in column 72.

1080262 (2527579)
• Using TOTAL or SUBTOTAL will now display the correct value instead of truncating the result.

584223 ( )
• Using SKIP=nL in the SECTIONS section of SORT will now cause the following behavior: 1)Under a

mainframe sort, (n/3 rounded up) blank lines (when n>0) will be skipped and the appropriate carriage
control character will be placed in column 1 of each blank line. 2) For sequential file organizations, the
same behavior will occur but no carriage-control characters will be printed. 3) For line sequential files, n
blank lines will be skipped.

1080092 (2525670)
• An RTS 252 error no longer occurs if RTS memory checking is enabled and outfil processing is used in

a sort card.

1081337 (2540109)
• Setting SORTSPACE to the same value as SORTTEMPSPACE no longer causes an RTS 252 to occur.

1081277 (2539633)
• SORTCOMPRESS=5 will no longer cause the records output from SORT to differ from the records that

are taken in.

1080006 (2518730)
• MFSORT will now accept the following constants in the outrec, header, and footer: * DATE1+n *

DATE1-n * DATE1(c)+n * DATE1(c)-n * DATE2+n * DATE2-n * DATE2(c)+n * DATE2(c)-n * DATE3+n *
DATE3-n * DATE3(c)+n * DATE3(c)-n * DATE1P+n * DATE1P-n * DATE2P+n * DATE2P-n * DATE3P
+n * DATE3P-n where n represents the number of days for DATE1 and DATE3, and number of months
for DATE2, and where c represents the date separator.

1079771 (2521778)
• The keywords CENTWIN and Y2PAST are now both accepted under both DFSORT and SYNCSORT

emulation.

585369 ( )
• Sort now closes down correctly after an RTS 163 error, and is now able to carry on and process further

jobs.

1082133 (2544148)
• When combining OUTFIL and SORTOUT files where headers and trailers were used, SORTOUT

sometimes contained mainframe printer control characters.

1082048 (2548488)
• When writing to EBCDIC files, DATE constants will now correctly be converted into EBCDIC format.

586917 ( )
• A SORT performed from REXX no longer causes a COBRTS 114 error.

1081942 (2546794)
• SORT will now correctly compare INCLUDE/OMIT parameters when SUM FIELDS=NONE.

1083014 (2558088)
• Setting MFJSSTRICTSORT=ON will now cause records that are shorter than the output file's LRECL to

be padded with low values instead of spaces.

1081919 (2547118)
• If a SUBSYS is specified and does not exist, SORT reverts to using EXTFH and emits a warning

message.
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1081570 (2542992)
• PARM RC16 is ignored but the comment line reports a warning.

1081203 (2537395)

Interface Mapping General

• User Exit 5 now allows the Web service response to be overridden.

1081015 (2516533)

MFSupportInfo

• MFSupportInfo now supports machines with greater than 4Gb of memory installed.

1076718 (2483333)

OLE Domain Support

• In-process COM objects no longer leak memory when used within Microsoft's Windows Communication
Foundation (WCF) framework.

1078908 (2509742)

RTS

• The Micro Focus run-time system is no longer unloaded prematurely when using IBM TXSeries, and
does not produce a COBRT 173 error.

1079371 (2516765)
• The run-time text window no longer returns incorrect data when content is copied from it using Edit/

Mark.

1078975 (2511669)
• The CBL_RENAME_FILE and CBL_COPY_FILE routines no longer cause a memory leak on UNIX

platforms.

1076845 (2484033)
• On Japanese Windows, the IME now consistently appears at the current cursor position when ANSI

ACCEPTs are done in the COBOL Text Window.

1079925 (2523680)
• If you run 32-bit XML Extensions on AIX and you are exporting a very large data item (over 60 Mb), you

can encounter error 72[6]: "Data conversion error text: Memory allocation error". To workaround this
issue, you need to set the LDR_CNTRL environment variable before running the program as follows:
LDR_CNTRL=MAXDATA=0x40000000; export LDR_CNTRL

586691 ( )
• Use of PC_PRINTER_DRAW_RECTANGLE, PC_PRINTER_GET_BMP_INFO,

PC_PRINTER_LINE_FROM_TO, PC_PRINTER_SET_BACKGROUND_MIX_MODE,
PC_PRINTER_SET_PEN or PC_PRINTER_SET_POSITION no longer give an unresolved symbol
error when linking as a 32-bit application.

1072571 (2418196)
• On Windows 7, building 64-bit native COBOL applications always rebuilt the entire project. This was

caused by the Microsoft FileTracker tool, used by the COBOL projects to track dependencies, not
working because of Windows 7 security updates. This product now includes a fix to work around this
issue.

588615 ( )
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Setup Issues

• The Visual COBOL R4 Web installer did not detect an existing installation of Visual COBOL R3 in a
custom directory. It removed Visual COBOL R3 and installed Visual COBOL R4 in the default location
without a prompt.

1080182 (2524759)

Setup Issues (UNIX)

• During installation, the install script checks a list of expected locations for the GCC compiler, and when
found, updates the cobopt file with that location. This list now includes locations appropriate for different
platforms and different levels of GCC compiler.

1081011 (2535964)

SQL Support (non-Compiler)

• The ODBC pre-compiler has been modified to properly support UTF-8 coded host variable names in
EXEC SQL statements.

1079019 (2512255)

SQL: COBSQL

• The Cobsql preprocessor has been updated to improve robustness of error handling when working with
Oracle Pro*COBOL on UNIX.

1082474 (2552830)

SQL: DB2 ECM

• The DB2 ECM has been updated to resolve run-time errors returned when compiling against mainframe
databases in 64-bit mode.

1082441 (2549058)

SQL: OpenESQL

• OpenESQL has been updated to support 64-bit operation for INSERT and FETCH statements.

1079765 (2499575)

Vision File System

• There is a new configuration option - RMFM_RUN_INDEX_FILES_PREVENT_WRITE_STARVATION.
The default value of this option is set to NO, but when set to YES, it enables the new additional locking
scheme that prevents write starvation when there are many active readers of the same file.

589086 ( )
• ACUFH incorrectly returned status 00 on OPEN INPUT of a non-existent OPTIONAL file. This has been

fixed so that ACUFH returns the correct status 05.

1082400 (2552367)
• An alternate key numbering mismatch occurred during the execution of the OPEN statement for an RM

indexed file.

1079788 (2521519)

XML Extensions

• XML EXPORT failed to output some occurrences from an OCCURS data item nested in another
OCCURS data item.
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1080752 (2533412)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
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3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location which does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installedMicro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus technical
support, your support representative might request that you provide additional debug files (as well as
source and data files) to help us determine the cause of the problem. If so, they will advise you how to
create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2012. All rights reserved.
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